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ABSTRACT 
 

Virtual tours ae tours that are used in place of real-world tours, conducted via computer, telephone, or 

other technology. These tours allow participants to see, explore and learn about the areas they are 

visiting virtually. Virtual tours can be used as a substitute for real world tours or as a complement to 

real world tours. Virtual tours offer advantages such as no transportation costs, no time and place 

limitations. In this thesis study, Evliya Çelebi campus of Kütahya Dumlupınar University was 

modeled in three dimensions and a virtual tour was carried out in the style of a game. Kütahya 

Dumlupınar University Evliya Çelebi campus is an important educational institution located in the 

city of Kütahya in western Turkey. The history of the university, the Seljuk architecture in its 

buildings and its cultural significance attract the attention of many people, such as students and 

parents. Therefore, a gamified three-dimensional virtual tour will help students, staff and other people 

explore the university. The application was designed using SketchUp to create a 3D model of Kütahya 

Dumlupınar University Evliya Çelebi campus. With the transfer of the model to Unity, the necessary 

elements were added for the preparation of an interactive virtual tour, audio characters that inform the 

users about the structures of the university during the virtual tour and student characters walking 

around during the tour were added to make them feel in the university environment. One of the most 

important features of the application is that it allows users to explore the university completely freely. 

Users can navigate the campus by walking, running or even flying with flight mode for a bird's eye 

view. This project, which was prepared in the Windows environment, can be made available for the 

application, IOS, Android and Web environments thanks to Unity's multi-platform support. 

 

Keywords: Virtual Tour, Campus Simulation, Unity, Sketchup 

 

 

KÜTAHYA DUMLUPINAR UNIVERSİTESİ 

3D SANAL TURU  

 

ÖZ 

 

Sanal turlar, gerçek dünya turların yerine kullanılan, bilgisayar, telefon veya diğer teknolojiler 

aracılığıyla gerçekleştirilen turlardır. Bu turlar, katılımcıların sanal olarak gezdikleri alanları görme, 
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keşfetme ve bilgi edinmelerine olanak tanır. Gerçek dünya turların yerine kullanılabildiği gibi, gerçek 

dünya turlarının tamamlayıcısı olarak da kullanılabilir. Sanal turlar, ulaşım maliyetlerinin olmaması, 

zaman ve mekân sınırlamasının olmaması gibi avantajlar sunar. Bu tez çalışmasında Kütahya 

Dumlupınar Üniversitesinin Evliya Çelebi yerleşkesi üç boyutlu modellenerek içerisinde oyun 

tarzında bir sanal gezinti gerçekleştirilmiştir. Kütahya Dumlupınar Üniversitesi Evliya Çelebi 

Yerleşkesi, Türkiye'nin batısındaki Kütahya şehrinde yer alan önemli bir eğitim kurumudur. 

Üniversitenin tarihi, binalarındaki Selçuklu mimarisi ve kültürel önemi, öğrenci ve veliler gibi birçok 

kişinin ilgisini çekmektedir. Bu nedenle, bir oyunlaştırılmış üç boyutlu sanal tur, öğrencilerin, 

personelin ve diğer insanların üniversiteyi keşfetmelerine yardımcı olacaktır. Uygulama, Kütahya 

Dumlupınar Üniversitesi Evliya Çelebi Yerleşkesi’nin 3D modelini oluşturmak için SketchUp 

kullanılarak tasarlanmıştır. Modelin daha sonra Unity'e aktarılması ile, interaktif bir sanal tur 

hazırlanması için gerekli öğeler eklenmiş, sanal tur boyunca kullanıcılara, üniversitenin yapıları 

hakkında bilgi veren sesli karakterler ile üniversite ortamında hissedilmesi için gezinti sırasında etrafta 

dolaşan öğrenci karakterleri eklenmiştir. Uygulamanın en önemli özelliklerinden biri, kullanıcıların 

üniversiteyi tamamen özgürce keşfetmelerine olanak tanımasıdır. Kullanıcılar, yürüyerek veya 

koşarak hatta kuşbakışı görmek için uçuş modu ile uçarak yerleşke içinde gezinebilirler. Windows 

ortamında hazırlanan bu proje Unity’nin çoklu platform desteği sayesinde uygulama, IOS, Android ve 

Web ortamları için de kullanılabilir hale dönüştürülebilmektedir. 

 

Anahtar Kelimeler: Sanal Tur, Kampüs Simülasyonu, Birlik, Taslak 

 

1. INTRODUCTION 

 

Universities are educational institutions, also called higher education, after secondary education, 

which are the dreams of students. They are especially distinguished institutions where the future lives 

of students are shaped and they are brought to life thanks to the education and training they receive. 

 

According to the statistical data kept in our country, 634,664 high school graduates as a result of YKS 

placements and 51,582 high school graduates as a result of YKS additional placements were placed in 

higher education institutions and became university students (Figure 1). 
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Figure 1. 2022 Higher education placement results[13]. 

 

Before settling in the university, students have great anxiety and excitement about which university 

they will choose. The size of the university campus, whether it has social activities or not, and even 

the differences in the faculty buildings play an important role in their preference. 

 

While making these choices, students may have to go to a place they do not know and visit 

universities. This situation brings with it both a time and a financial burden. But; The fact that all 

universities have an interactive virtual tour application will eliminate the loss of time and money in 

their preferences, and it will be easier to get information about the university. 

 

Evliya Çelebi campus of Kütahya Dumlupınar University is modeled in three dimensions, and users 

who want to see the university and get information about the university can create an interactive 

virtual tour. It is aimed to enable them to travel and see in the computer environment in the style of 

computer. 

 

2. LITERATURE REVIEW 

 

In order to shed light on the three-dimensional virtual tour application of Kütahya Dumlupınar 

University, studies in the fields of virtual tour and virtual campus have been researched. As a result of 

the literature review, similar studies to our application are as follows. 

 

(Yılmaz, 2008)’s master's study titled "Creating a three-dimensional interactive virtual environment" 

examined the Sakarya University Esentepe campus, interaction experiments using the Multigen-

Paradigm Creator program. For the interaction experiments, Vega LynX program was used, but it was 

emphasized that there were also software deficiencies[1]. 
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In (Doker & Kirlangiçoglu, 2018)’s research titled “Introducing cultural heritage through the Virtual 

Museum Platform, Hagia Sophia Study”, the Hagia Sophia Museum is modeled and textured with 

three-dimensional modeling software and high-resolution photographs, and its surroundings are 

modeled by removing the triangulated irregular network. They emphasized that the Unity game engine 

was used for the tour. They also explained that users were able to navigate freely throughout the 

project and learn about the details. However, it is understood that the navigation is only provided by 

viewing the interior and exterior of the building without interaction and obtaining information. In 

addition, the researchers concluded that the three-dimensional virtual museum study can be an 

alternative to the traditional type in order to reach more people on a national and global scale[6]. 

 

(Akin & Uzun, 2022)’s work “Design and application of Virtual Reality for the automotive industry”; 

revealed the experiences of users in the VR environment, who examined the interior and exterior 

designs of the vehicles exhibited in a vehicle gallery. Researchers; They used the Blender program for 

three-dimensional modeling and the Unity game engine for interaction. Belender modeled a vehicle 

gallery and the vehicles in it, and after transferring this model to the unity game engine in fbx format, 

users were able to interact with the vehicle they chose with their vehicle selection and changing the 

colors of the vehicles. As a result of the implemented application, it has been revealed that the users 

have eye pain or tearing problems with long-term use of the VR glasses, and despite the negativities, 

virtual reality is a different experience and they have fun. In addition, in the surveys they made on the 

users, “Have you had a VR experience before?” To the question “How would you like the design to be 

in VR?” to the question “How would you like the design to be in VR?”, 38% of the users answered 

yes and 62% said “How often do you plan to use VR applications?” " to the question; It was observed 

that 27% answered several times a week, 19% once a month, and 12% several times a year[10]. 

 

In (Içten, 2021)’s study titled “Interactive 3D Virtual Environment for the Education of Traffic Safety 

Rules and Signs”, in the research, it was examined whether the virtual environment would be a 

solution for the real traffic rules education of pedestrians and driver candidates. The researcher 

explained that the virtual environment modeled with 3DSMax uses the Unity game engine for use, 

Leap Motion for hand tracking, and Oculus Rift for VR imaging device. He also explained that he 

uses independent software (SketchUp, Blender, Maya, etc.) for the modeling of solid objects (vehicle, 

roads, etc.). It has been revealed that 90% of the users of the virtual training simulation stated that the 

developed tool is useful, fun and educational. In addition, users; He also mentioned that hand fatigue 

caused by the use of Leap Motion device and eye pain caused by VR device. It is among the results of 

the research that distance education can be given to users safely in the world where global epidemics 

take place. It has been understood from the study that the Leap Motin device used in the application 

does not detect movements in low light environments, and the Oculus Rift device does not support the 

versions of the Windows operating system before the Windows 10 version[8]. 

 

In (Erbas & Tuncel, 2022)’s research titled “Re-functioning of cultural assets in the virtual 

environment: The example of the Basilica cistern”, it is explained that the most important benefit of 

re-functioning in the virtual environment is to prevent possible negative consequences without 

damaging the structure. In addition, it was emphasized that visitors who want to visit the work in the 

virtual environment can make their visits without regional and country borders. Researchers; After 

converting the point cloud data obtained by terrestrial laser scanning method of the Basilica cistern to 

PTS or E57 format, they were displayed by the 3D Max program through the Autodesk Recap 

program and modeled, interacting with the unity game engine and enabling it to be run in both VR and 

web environments. Although it was stated in the study that the terrestrial laser scanning method of 
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modeling produced point cloud data with coordinates and real scale; It is understood that the RIEGL 

VZ-400 laser scanning device used in the study costs 120,000$ [14] and therefore causes a very high 

cost[11]. 

 

In (Oztel & Oz, 2018)’s study titled “Traffic Training for Inexperienced Drivers with a Virtual 

Driving Simulator”, they designed a virtual driver simulator for traffic safety. The researchers, who 

modeled the buildings, signaling system, roads, traffic signs and vehicles in the platform with the test 

platform using Sketchup 3D modeling program, declared that they created a simulation with the Unity 

Game Engine and the car they bought from the Unity asset store. Also the driver; They control the 

simulation using the hardware called Logitech G25 Racing Wheel, and they stated that they gained 

experience about driving skills and traffic rules thanks to this system. They declared that the training 

was carried out in a fun way without real life risks. It has been observed that interaction is gained by 

moving the vehicle to the study[5]. 

 

(Memduhoglu, Senol, & Akdag, 2020)’s research titled "3D Map Experience with Virtual/Augmented 

Reality Applications"; Researchers photographed Harran University Osmanbey Campus by means of 

an unmanned aerial vehicle, and after mapping, three-dimensional modeling was carried out with 

ESRI CityEngine software. Thanks to the application, which was made interactive using the Unity 

game engine, it was seen that young students in the high school equivalent age group were able to take 

a stroll on the tablet screen at the Şanlıurfa Science Festival. Although it is seen that the work 

provides navigation without any characters, it reduces user interaction; It was understood that it was 

used with great care and excitement by young students thanks to the tour made independently of place 

and time[7]. 

 

In (Avzal, Ozdemir, & Erarslan, 2022)’s research titled “Design of Promotional Application Examples 

for Touristic Purposes Using Augmented and Virtual Reality Technologies of the Ancient City of 

Aizanoi”; It is about the use of virtual and augmented reality technologies to virtually tour the temple 

of Zeus in the ancient city of Aizanoi in the Çavdarhisar district of Kütahya. As a result of 

photogrammetric photographing by drone on the temple in question, the researchers produced three-

dimensional modeling of the photographs using Bentley ContextCapture software. Stating that the 

application was coded with the C # language by the Unity game engine, the researchers stated that the 

application would be helpful for individuals who cannot travel due to distance and economic situation. 

In the work created by combining the photographs, it is seen that the model of the Zeus temple is 

transferred to the real environment by using vuforia application and VR technology to interact with 

real areas. In addition, it is understood that a game called gold collection, designed with virtual reality, 

was designed in the study, so that the place was visited interactively[9]. 

 

Within the scope of (Tiryakioglu, and others, 2016)s’ BAP project, in their study titled “3D Building 

Modeling and WEB Based Presentation: The Example of Ahmet Necdet Sezer Campus”, for the 

promotion of Afyon Kocatepe University ANS campus, those who want to visit the university on the 

internet, take 3600 photos of the campus and combine them with the PhotoModeler program. They 

explained that a virtual tour was created and for those who want to see the university from Google 

Earth program, using AutoCad and 3DS Max programs, most of the campus buildings are modeled in 

3D and uploaded to the Earth program. For the web-based navigation application, it is understood that 

a tour is made by combining the photos, but a virtual tour is created by seeing the three-dimensional 

photos by simply moving from one point to another[4]. 
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(Luqi & Ligang, 2012)‘s papers titled “Virtual Campus Design and Development”, an application was 

created on a character produced by two-dimensional modeling of Zhejiang Gongshang University 

using Flash-based AS 3.0 programming language, by finding the shortest path from point A to point 

B. In addition, they stated that they carried out this study in order to facilitate the visitors to obtain 

effective information while browsing the virtual campus. In addition, the researchers who interacted 

with the character explained that most people wanted to see the tour in two dimensions, and that there 

was no sense of interaction and experience from the school's website. They suggested that it is 

important that visitors can see all the places in two dimensions and start wandering instead of 

wandering the roads in three-dimensional models. It is understood that some videos or images are 

played by clicking on some points on the application, giving information about the university. 

However, considering that there were three-dimensional models in 2012, it is understood that the 

campus, which was created with two-dimensional models in the study, did not attract much attention 

over the years[3]. 

 

3. MODELING OF KUTAHYA DUMLUNAR UNIVERSITY and REALIZING A VIRTUAL 

TOUR GAME 

 

SketchUp and Unity are popular software that can be used to create virtual tours. SketchUp is 3D 

modeling software and Unity is a game engine used for the creation of games and virtual reality 

applications.  

 

Sketchup is designed to quickly create 3D images. It is used to design models of buildings, furniture 

and other everyday objects, design patterns with interior and exterior details such as one-room houses, 

and special architectural elements such as pitched or complex roofs. It can add color and texture to the 

models made in a very simple way. It also helps to organize the surrounding of buildings[2]. 

 

Unity is an application that game designers often use. The reasons for this are; such as supporting 

high-level languages, working with Visual Studio IDE environment, adding Android SDK and JDKs 

by unity, providing development for multiple platforms, providing an environment free of charge for 

those developed up to a certain profit[12]. 

 

The 3D model of Kütahya Dumlupınar University Evliya Çelebi campus to be created in SketchUp 

can be imported into Unity and a virtual tour application can be created thanks to this application. In 

Unity, your virtual tour can be made more realistic by moving the camera, adding lighting and visual 

effects, and adding interactive objects. Implementation of the application consists of 5 stages (Figure 

2). 
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Figure 2. Application stages.  

 

3.1. Modelling          

For the Virtual Tour application, Kütahya Dumlupınar University Evliya Çelebi campus was selected 

and modeled. Before modeling, the ground was prepared by laying the campus sketch taken from the 

Google Earh application on the X-axis of the SketchUp program. It has been ensured that the 

buildings and structures that we will construct are located according to this sketch. 
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Figure 3. Adding Dumlupınar University location on map to sketchup. 

 

In order to assist in the modeling of buildings and structures, after taking the sketch, the road, pool 

sections, parts of the buildings and structures where they will be located were created. 

 

 

Figure 4. Adding Dumlupınar University location on map to sketchup. 
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After the ground was prepared, the building and building models were formed on the gaps left on the 

ground. The structures created are Crown Gate, Rectorate building, Bedesten building, Climbing wall, 

Martyr Petty Officer Ömer Halisdemir Library, Faculty of Literatüre and Sciences and Faculty of 

Engineering buildings. 

 

 

Figure 5. The completed version of the model. 

 

3.2. Scene Creation 

To create a scene in Unity, use the "File" > "New Scene" option in the Unity interface. This allows a 

new scene to be created and worked within the scene. To be able to import the 3D model into Unity, 

in SketchUp the model must be exported to FBX format with the "File" > "Export" option. Next, the 

FBX file is imported using the "Assets" > "Import New Asset" option in the Unity interface. The 

model is added to the "Assets" folder of the project and drag and drop method is used from the 

"Scene" panel to use it in the scene.  

 

Since the playing field is in infinity, it is necessary to prevent the player from going out by raising the 

edges of the playing field. For this operation, a terrain is added under the floor. By selecting the 

terrain from the hierarchy window, elevation can be given from the properties in the inspector 

window. 

 

3.3. Selection of Characters and Animations 

Mixamo is a web-based application developed by Adobe. Mixamo allows you to easily create and edit 

animated 3D characters. You can become a member for free and the created characters and animations 

can be used as open source free of charge. 

 

Mixamo supports many file formats to export the generated character, including .fbx, .dae, .3ds, .dxf, 

.obj, .blend, .glTF and .gltf. Among these formats, the most suitable one for Unity can be selected. 

 

For unity, the character created from Mixamo is saved to the computer in .fbx format. Drag and drop 

from Unity's Project window into the assets folder. Thus, its copy is integrated into the project file. In 
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addition, animations such as idle, walking running, right strafe, left strafe, walking backwards, which 

will be applied to the character from mixamo, have been downloaded separately. 

 

 

Figure 5. Student characters selected from Mixamo. 

 

3.4. Adding Assets to the Scene 

Unity Asset Store is the official plugin and resource store for Unity software. This store contains a 

variety of plug-ins, tools, model, audio, video, and other resources created and shared by Unity users. 

These resources can be used to develop Unity projects. 

 

Products in the Asset Store are available for free or for a fee. Paid products often include pro-grade or 

more features. The searched resource can be accessed by searching the Asset Store or using category 

filters. 

 

Various assets are needed in order to increase visuality and realism within the campus of Kütahya 

Dumlupınar University. For example, the tables and chairs to be found in the cafeteria, the vehicles to 

be found in the parking areas in front of the buildings, the characters to promote the buildings, the 

cash machines to be found in the University, the afforestation of the land. 

 

 

Figure 6. Added state of assets. 
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3.5. Coding of the Game Engine 

Unity supports many programming languages such as C#, UnityScript (which is a JavaScript-like 

language), and Boo (which is a Python-like language). C# is considered an officially supported and 

recommended language by Unity. UnityScript and Boo are the less popular language options 

supported by Unity. Unity uses a kernel called IL2CPP to optimize the performance of code written 

by C#. This makes C# code interoperable across platforms. 

 

IL2CPP is a kernel used by Unity to improve the performance of C# code. This kernel is an 

intermediary that compiles and runs C# code for the final platform (e.g. iOS or Android). The working 

logic of IL2CPP is as follows. C# code is primarily compiled as CIL by a Unity-executed JIT 

compiler. Next, the IL2CPP tool compiles this CIL code to platform specific and eventually converts 

it to C++ code. This C++ code can be run directly on the final platform[15]. 

 

 

Figure 8. The Configuration section of the Player settings [15]. 

 

A life cycle has been created for the virtual tour application. After the user runs this application, he 

can continue to use this life cycle (Figure 9). 
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Figure 9- Application lifecycle. 

 

C# scripts were used for the movement of the characters in the virtual tour application and for 

transitioning to animations. Visual studio program was used to create C# scripts. The script created for 

each object will be added to the object in question by clicking the add component button from the 

inspector window after selecting the object under the hierarchy window. 

 

Five targets were determined for the student characters placed in the virtual tour. While the scene is 

loading, the characters are allowed to walk to random targets to be selected by software, and if they 

reach the target, a new target is selected and directed to that target. 

 

For student characters to go to randomly selected targets; The Navigation feature of the scene needs to 

be activated. The Navigation window, which is the submenu of the AI menu in the Window menu, is 

opened, the floor for Navigation is selected from the hierarchy window, and the artificial intelligence 

functionality of Unity is activated by clicking the Bake button from the Bake menu in the Navigation 

window. The important point is; It is the Bake of the buildings and structures that cannot walk through 

the characters by leaving them out of selection. 
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For the characters positioned on the sides of the Faculty of Literatüre and Sciences and the Faculty of 

Engineering, when the main character enters the range of this character who will make the 

introduction, it is ensured that the main character turns to the direction he came from and his face 

always turns to the main character, no matter which direction he turns. In addition, when our main 

character approached the promoting character, the speaking animation of the promoting character was 

run and the introduction of the faculty in question was explained by speaking with a sound effect 

(Figure 10). 

 

 

Figure 9. Speech animation of the introductory character. 

 

4. RESULTS and CONCLUSION 

 

The application was developed on the Dell Precision Tower 3620 desktop computer. It has Intel Xeon 

E3-1225 v5 as processor. Features of the processor; It has 4 cores, a base frequency of 3.30 GHz, 8 

Mb Intel® smart cache and draws 80W of power. The computer has 16GB of ram. A Philips 75Hz 

1ms monitor was used as a display. After the application developed with this computer, it was 

investigated whether the application with external graphics cards would cause problems graphically. 

 

Table 1- Tested graphics cards. 

Graphics Card Memory 

Type 

Memory Size Memory 

Speed 

Memory 

Interface Width 

Ati Radeon HD 4350 DDR2 512 Mb 600 MHz 64 bit 

Nvidia GT 220 DDR3 1024 Mb 1000 MHz 128 bit 

Nvidia Quadro K420 DDR3 2048 Mb 900 Mhz 128 bit 

Nvidia RTX 2060 DDR6 6144 Mb 14000 Mhz 192 bit 

 

FPS values were measured by changing the graphics cards on the same computer system. FPS (frames 

per second) is referred to as the number of frames per second on the display screen. The higher the 

FPS value, the higher the fluency in the virtual tour. FPS measurement can be done with 3rd party 

software, or FPS values can be obtained with the Windows logo key + G key combination over the 
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Windows 10 operating system. Too many FPS values may not always be viewed positively. For 

example, graphics that will be displayed over 60 FPS with a 60 Hz monitor can sometimes cause 

breakage. This situation is called screen tearing. For this reason, the repetition rate of the monitor is 

important as well as the FPS value. 

 

 
Figure 10- Average FPS values. 

 

Although the graphics cards are old, it has been observed that there is not much difficulty in visiting 

the virtual tour. The application can run on both 32 and 64 bit operating systems thanks to the unity 

program. The virtual tour application was tested by approximately 40 people aged 17-35 in Kütahya. 

As a result of the test, users were asked to fill in the created questionnaire and it was seen that 25 

people participated in the questionnaire [16].  

 

“What is the ease of use of the virtual tour application?” 84% answered the question as easy and 16% 

as medium. In the question asked to the users about whether the presence of a character in the virtual 

tour application increases the effectiveness, all users "definitely increased the effectiveness of the 

application." They gave the answer. In order to increase the interaction in the implementation of the 

application, the characters with speech animations are placed next to the faculty buildings for the 

promotion of the faculties. When this character is approached, the character changes its direction to 

the main character and gives information about the faculties with speech animation. This situation was 

presented to the appreciation of the users, and they were asked whether the audio promotion was 

valuable or not, and 72% of the users stated their opinion as very valuable, 24% valuable, and 4% 

whether it is or not. Our application has been compiled on the windows platform and presented to the 

user experience. For this reason, users were asked on which platform the application should be, 48% 

of the users explained that it should be a web environment, 28% a desktop application, and 24% a 

phone-tablet application. The virtual tour application modeling was modeled in three dimensions in 

SketchUp program. In the research of [3], users were asked about this situation based on the opinion 

that it would be more interesting for users to see the whole model at the same time with two-

dimensional modeling, and all users agreed that such applications should be designed in three 

dimensions.  
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According to all these studies, it has been observed that, unlike other literature, a fully interactive 

application satisfies the users. As the pandemic process shows, especially when the cost is considered, 

especially when there is a health and safety risk; The necessity of these applications, which provide 

information about buildings and structures with navigation without the concept of time and space, is 

obvious. 

 

5. DISCUSSION 

 

In this study, Kütahya Dumlupınar University Evliya Çelebi Campus was modeled in three 

dimensions and developed as a game-style virtual tour. The study was tested on different computers 

with different users, and some users found it interesting to fly with characters, and some users stated 

that such an application should be in all universities. 

 

Virtual tour application implemented for the Windows environment, thanks to the transition feature of 

the Unity game engine to various platforms; Those who want to develop the application can use it by 

building it for WEB, IOS, and Android platforms. In addition, thanks to Unity's AI feature, developers 

will be able to solve the problem of where and how users go, by adding another character to the 

application and directing this character to the desired target.  

 

6. ACKNOWLEDGEMENT 

 

The author does not have any person or organization to thank. 

 

 

REFERENCES  

 

[1] Yılmaz, Z. (2008). Creating a three-dimensional interactive virtual environment. Sakarya. 

 
[2] Grover, C. (2009). Google SketchUp. O'Reilly Media, Inc. 

 

[3] Luqi, X., and Ligang, D. (2012). Virtual Campus Design and Development. 9th International 

Conference on Fuzzy Systems and Knowledge Discovery (s. 2949-2952). Chongqing, China: 

IEEE. 

 
[4] Tiryakioglu, I., Uysal, M., Erdogan, S., Yalcin, M., Polat, N., and Toprak, A. S. (2016). 3D 

Building Modeling and Web Based Presentation: Ahmet Necdet. Afyon Kocatepe University 

Journal of Science and Engineering Sciences, 107-114. 

 
[5] Oztel, I., and Oz, C. (2018). Traffic Education for Inexperienced Drivers with Virtual Driving 

Simulator. Sakarya University Journal Of Computer and Information Sciences, 82-88. 

 
[6] Doker, M. F., and Kirlangiçoglu, C. (2018). Promotion of Cultural Heritages Through A Virtual 

Museum Platform: Case Study Hagia Sophia. Sakarya University Journal Of Science, 1337-

1345. 

 
[7] Memduhoglu, A., Senol, H. I., and Akdag, S. (2020). 3D Map Experience with 

Virtual/Augmented Reality Applications. Harran University Journal of Engineering, 175-182. 



 

 
 

 

Gökkuş, M. ve Serttaş, S., Journal of Scientific Reports-B, Sayı 7, 30-45 Haziran 2023 
Gökkuş, M. and Serttaş, S., Journal of Scientific Reports-B, Number 7, 30-45, June 2023 

 

 
 

45 
 

[8] Içten, T. (2021). Interactive 3D Virtual Environment for Education of Traffic Safety Rules and 

Signs. Journal of Information Technologies, 191-206. 

 
[9] Avzal, A., Ozdemir, D., and Erarslan, K. (2022). Design of Promotional Application Examples 

for Touristic Purposes Using Augmented and Virtual Reality Technologies of the Ancient City 

of Aizanoi. ESTUDAM Journal of Informatics, 66-73. 

 
[10] Akin, M., and Uzun, Y. (2022). Application Design and Implementation for the Automotive 

Industry with Virtual Reality. Hittite Journal of Science and Engineering, 133-143. 

 
[11] Erbas, H. E., and Tuncel, D. (2022). Re-functionalizing Cultural Heritage in Virtual 

Environment: The Example of Yerebatan Sarnici. European Journal of Science and Technology, 

362-372. 

 
[12] Ulusoy, Ç. S. (2022). An Augmented Realıty Applıcatıon Usıng Unıty And Vuforıa. Edirne. 

 
[13] Higher Education Information Menegament System. (2022, 12 8). https://istatistik.yok.gov.tr/  

 
[14] Aniwaa. (2022, 12 22). https://www.aniwaa.com/product/3d-scanners/riegl-vz-400i/  

 
[15] Unity Documentation. (2023, 1 3). https://docs.unity3d.com/Manual/IL2CPP.html  

 
[16] Google Form. (2023, 1 28). 

https://docs.google.com/forms/d/e/1FAIpQLSebZgju8byxwspI5EsFQRRnLwh1UohpSluy-

KFz6UivIB5d5A/closedform 

https://istatistik.yok.gov.tr/
https://www.aniwaa.com/product/3d-scanners/riegl-vz-400i/
https://docs.unity3d.com/Manual/IL2CPP.html

